GETTING STARTED GUIDE
NI High-Speed Digitizers

This document explains how to install, configure, and test NI high-speed digitizers, and how to begin programming them using the NI-SCOPE instrument driver software. This document applies to the following digitizers: NI 5102, NI 5105, NI 5112, NI 5114, NI 5122, NI 5124, NI 5142, NI 5152, NI 5620, NI 5621, NI 5911, and NI 5922.

For more information on features and programming, refer to the NI High-Speed Digitizers Help. For NI high-speed digitizer specifications, refer to the specifications document included with your digitizer. Both documents are available at Start»All Programs»National Instruments»NI-SCOPE»Documentation.

For the most current versions of documentation, visit ni.com/manuals. For the latest version of NI-SCOPE, visit ni.com/idnet.

Contents

Conventions ...............................................................................................2
1. Verifying System Requirements............................................................3
2. Unpacking ..............................................................................................3
3. Verifying the Kit Contents.....................................................................4
   Other Required Items .........................................................................5
4. Installing the Software ...........................................................................5
5. Installing the Hardware..........................................................................6
   PXI Modules ......................................................................................6
   PXI Express Modules ........................................................................7
   PCI Devices .......................................................................................8
6. Configuring and Testing in MAX..........................................................10
7. Programming the Digitizer .................................................................12
   Acquiring Data Interactively .............................................................12
   Acquiring Data Programmatically .....................................................12
   NI-SCOPE Examples.........................................................................12
   NI Example Finder.....................................................................12
8. Making Your First Measurement...........................................................12
Appendix A: Front Panels for SMC-Based Devices .........................13
NI 5105 Front Panels .....................................................................14
NI 5114 Front Panels .....................................................................15
NI 5122/5124/5142/5922 Front Panels ..........................................16
NI 5152 Front Panels .....................................................................18

Appendix B: Front Panels for Traditional NI-DAQ (Legacy) Devices ..19
NI 5102 Front Panels .....................................................................19
NI 5112 Front Panels .....................................................................23
NI 5620/5621 Front Panels .............................................................24
NI 5911 Front Panel .......................................................................25

Appendix C: Troubleshooting ..........................................................26
Front Panel ACCESS LED on PXI Module is Off
  When PXI Chassis is On.................................................................26
Device Does Not Appear in MAX ...................................................26
Device Failed the Self-Test...............................................................27
Thermal Shutdown Error .................................................................27
Performance Issues Using MXI Connections ...............................27
Setting Up SMC-Based Devices for Synchronization .....................28
NI 5112 Programming Practices .....................................................28

Appendix D: Where to Go for Support .............................................29

**Conventions**

The following conventions are used in this manual:

» The » symbol leads you through nested menu items and dialog box options to a final action. The sequence *File > Page Setup > Options* directs you to pull down the *File* menu, select the *Page Setup* item, and select *Options* from the last dialog box.

💡 This icon denotes a tip, which alerts you to advisory information.

📝 This icon denotes a note, which alerts you to important information.

⚠️ This icon denotes a caution, which advises you of precautions to take to avoid injury, data loss, or a system crash.

**bold** Bold text denotes items that you must select or click in the software, such as menu items and dialog box options.

*italic* Italic text denotes emphasis or a cross-reference.
1. Verifying System Requirements

Your system must meet certain requirements to use NI high-speed digitizers with NI-SCOPE. For more information on minimum system, recommended system, and supported application development environments (ADEs), refer to the *NI-SCOPE Readme*, which is available on the NI-SCOPE CD.

Note: After you install NI-SCOPE, you can access the *NI-SCOPE Readme* file at Start> All Programs> National Instruments > NI-SCOPE > Documentation.

2. Unpacking

NI high-speed digitizers are shipped in an antistatic bag to protect them from electrostatic discharge (ESD). Prior to removing the digitizer from the bag, touch the antistatic bag to a metal part of the chassis to remove any built up static charge.

Caution: When handling the digitizer, make sure that you are grounded with a grounding strap or you are touching a grounded metal object. Handle the digitizer carefully to avoid touching any exposed pins or electronic circuitry.
Remove the digitizer from the package, remove the packing foam and rubber screw covers (PXI/PXIe devices only), and inspect the digitizer for loose components or signs of damage. Notify NI if the digitizer appears damaged in any way. Do not install a damaged digitizer into your computer or chassis.

Store the digitizer in the antistatic bag when not in use.

3. Verifying the Kit Contents

The following items are included in the NI high-speed digitizer kit:

- An NI high-speed digitizer, shown in the following table.

<table>
<thead>
<tr>
<th>Traditional NI-DAQ (Legacy) Devices</th>
<th>SMC-Based Devices</th>
</tr>
</thead>
<tbody>
<tr>
<td>NI PXI/PCI-5102</td>
<td>NI PXI/PCI-5105</td>
</tr>
<tr>
<td>NI PXI/PCI-5112</td>
<td>NI PXI/PCI-5114</td>
</tr>
<tr>
<td>NI PXI-5620</td>
<td>NI PXI/PCIXe/PCI-5122</td>
</tr>
<tr>
<td>NI PXI-5621</td>
<td>NI PXI/PCI-5124</td>
</tr>
<tr>
<td>NI PCI-5911</td>
<td>NI PXI/PCI-5142</td>
</tr>
<tr>
<td></td>
<td>NI PXI/PCI-5152</td>
</tr>
<tr>
<td></td>
<td>NI PXI/PCI-5922</td>
</tr>
</tbody>
</table>

Note  Legacy devices are those devices that are configurable in Measurement & Automation Explorer (MAX) under Traditional NI-DAQ (Legacy) Devices. SMC-based devices are based on the National Instruments Synchronization and Memory Core (SMC) architecture. SMC-based devices are configurable in MAX under NI-DAQmx Devices. For more information, refer to the NI High-Speed Digitizers Help.

- NI-SCOPE instrument driver DVD-sized case, which contains the following:
  - NI-SCOPE driver software CD
  - NI High-Speed Digitizers Getting Started Guide

- Other included items:
  - The specifications document for the digitizer
  - Read Me First: Safety and Radio-Frequency Interference
  - Maintain Forced-Air Cooling Note to Users
    (SMC-based devices only)
  - NI Spectral Measurements Toolkit CD (SMC-based devices with memory options higher than 8 MB only)
Other Required Items
In addition to the items contained in the kit, you need the following items:

❑ 1/8 in. flat-head screwdriver

❑ One of the following configurations:
  – **(PXI Devices)** A PXI chassis, a PXI/SCXI combination chassis, or a PXI/CompactPCI chassis with a controller and the chassis documentation

  *Note* If your application uses NI-TClk synchronization, you must use a PXI chassis. For more information, refer to [NI High-Speed Digitizers Help](https://ni.com/help) » Programming » NI-TClk Synchronization Help.

  – **(PXI Express Devices)** A PXI Express chassis with a controller and the chassis documentation
  – **(PCI Devices)** A desktop computer and its documentation

4. Installing the Software

⚠️ **Caution** Make sure you install the software *before* you install the hardware.

To install the software, complete the following steps:

1. (Optional) If you are using an application development environment (ADE) such as LabVIEW or if you are using a third-party tool, install it now. You *must* install the ADE before installing the NI-SCOPE instrument driver.

2. Install NI-SCOPE by inserting the NI-SCOPE CD into the CD drive and clicking [Install Software](https://ni.com/support/install) in the displayed window.

  *Note* If the installation window does not appear automatically, navigate to the CD drive and double-click `setup.exe`.

3. Follow the instructions in the installation prompts. For troubleshooting and operating system-specific instructions, refer to the Hardware Installation Wizard at [ni.com/support/install](https://ni.com/support/install).

  *(Windows Vista)* Users may see access and security messages during installation. Accept the prompts to complete the installation.

4. When the installer completes, a dialog box prompts you to Restart, Shut Down, or Restart Later. Select **Restart**.

5. If you are using a system running the LabVIEW Real-Time Module, download NI-SCOPE to the target using MAX. For more information,
5. Installing the Hardware

This section describes how to install hardware for PXI and PCI platforms.

**Note** You must install the software before you install the hardware.

To prevent damage to the device caused by ESD or contamination, handle the device using the edges or the metal bracket. For more information, refer to the Read Me First: Safety and Radio Frequency Interference document.

**Caution** You must power off and unplug your PC or chassis before installing the hardware.

**PXI Modules**

NI PXI modules are sensitive instruments that should be handled carefully. Do not expose the module to temperatures or humidity beyond the rated maximums. Keep the module free of dust by cleaning with compressed air only. Do not clean the device with any solvents or liquids.

You can install PXI modules in any PXI slot marked with a peripheral slot compatibility glyph (a circle containing the slot number).

To install a PXI module, complete the following steps:

1. Power off and unplug the PXI chassis before installing a PXI module.
2. If the PXI chassis has multiple fan speed settings, make sure that the fans are set to high.
3. Position the PXI chassis so that inlet and outlet vents are not obstructed. For more information, refer to the chassis documentation.
4. Make sure that the ejector handle is in the unlatched (downward) position.
5. Holding the module by the ejector handle, slide it into an empty slot. Make sure that the base engages with the guides in the chassis.
6. Slide the module completely into the chassis and latch it by pulling up on the ejector handle.
7. Tighten the captive screws at the top and bottom of the module front panel. Performance may suffer if both screws are not tightened properly.
8. Verify that the PXI chassis fans are operable and free of dust and other contaminants that may restrict airflow.
9. Before operating the module, cover all empty PXI slots using PXI filler panels or slot blockers, which you can purchase at ni.com.

10. Plug in and power on the PXI chassis.

**Figure 1. PXI Module Installation**

**PXI Express Modules**

Follow the installation instructions in the *PXI Modules* section and install the module in a PXI Express slot of the chassis. Refer to the chassis documentation for information about the markings that denote PXI Express slots.

**Figure 2. PXI Express Module Installation**
PCI Devices
To install a PCI device, complete the following steps:
1. Power off and unplug the PC.
2. Remove the PC cover.
3. Insert the device into an open PCI slot as shown in Figure 3.

**Figure 3.** PCI Installation

<table>
<thead>
<tr>
<th>1</th>
<th>NI PCI Device</th>
<th>2</th>
<th>PCI Slot</th>
<th>3</th>
<th>PC</th>
</tr>
</thead>
</table>

**Tip** To maximize airflow and extend the life of the PCI device, leave any adjacent PCI slots empty.

*(NI PCI-5911)* When you install the NI PCI-5911, verify that the BNC connector is centered in the metal frame of the chassis, as shown in Figure 4. Signal degradation can occur if the outer shell of the BNC connector touches the computer chassis. To minimize noise, do not allow the shell of the BNC connector to touch or lie near the metal on the PC.
Multiple NI 5911 devices in the same computer can raise operating temperatures beyond specification and produce imprecise data. NI strongly recommends leaving an empty PCI slot between multiple NI 5911 devices or adding a fan.

4. Secure the device to the PCI chassis with a screw.

![Figure 4. NI PCI-5911 Installation](image)

**Caution** It is important to completely screw the device front panel into the PCI slot, both for mechanical stability and to create a solid ground connection. Improperly secured devices may affect the accuracy of the device.

(SMC-Based Devices) Some computer manufacturers use a securing lever made of plastic to secure PCI devices; such a lever is unacceptable and must be removed. Use the screw provided in the kit to screw down the digitizer. Otherwise, you must use a different computer chassis.

5. Replace the PC cover.

6. Plug in and power on the PC.

7. (SMC-Based Devices) Verify that spread-spectrum clocking is enabled in the PC BIOS. For information about how to verify this setting, refer to the PC user documentation.

**Note** For SMC-based devices, spread-spectrum clocking varies the clock signal to spread the timing clock signal over a small frequency range. Disabling spread-spectrum clocking may affect the accuracy of device specifications.
6. Configuring and Testing in MAX

**Note** When you configure your device in MAX, remember that all SMC-based devices are configured under NI-DAQmx, and are referred to in MAX as NI-DAQmx devices. However, after you configure these devices in MAX, you use NI-SCOPE to program them.

1. Launch MAX.
2. Expand **Devices and Interfaces** to see the list of installed devices. If you are using a digitizer with the LabVIEW Real-Time Module, expand **Remote Systems**. Find your target IP address or name, expand it, and then expand **Devices and Interfaces**.

   The configuration tree lists both Traditional NI-DAQ (Legacy) devices and NI-DAQmx devices.

3. If your device is not listed, press <F5> to refresh. If the device is still not listed, repeat the steps in section 5. **Installing the Hardware**. For more information about using MAX, refer to the help files available within MAX.

**Note** Windows Vista does not support some Traditional NI-DAQ (Legacy) devices. Refer to the **NI-SCOPE Readme File** to determine which operating system is compatible with your digitizer.

4. Record the device number or device name assigned by MAX. You need this number when you program your device.

   - **(Traditional NI-DAQ (Legacy) Devices)** Select the device to see its properties in the configuration view. The device number appears in the Value column. By default, the resource name for the device is `DAQ::n`, where `n` is the device number MAX assigned to your device. NI-SCOPE devices that are configurable under Traditional NI-DAQ are not supported by the LabVIEW Real-Time Module.

   - **(NI-DAQmx Devices)** The assigned device name is appended to the device in its configuration tree label. For example, after you install the digitizer, the device configuration tree label may appear as `NI PXIe-5122: "Dev1"`, where `Dev1` is the device name. When you develop your application, the resource name is the device name assigned by MAX. Only the NI-SCOPE devices that appear under NI-DAQmx Devices are supported by the LabVIEW Real-Time Module.
Note To avoid modifying existing applications that use a Traditional NI-DAQ (Legacy) device number, change the assigned NI-DAQmx device name by right-clicking on the device, selecting Rename, and entering the Traditional NI-DAQ (Legacy) device number used in your application. For more information about device naming conventions, refer to the niScope_init function or the niScope Initialize VI at NI High-Speed Digitizers Help» Programming»Reference.

5. Perform a self-test on the device to verify installation.
   (Traditional NI-DAQ (Legacy)) Right-click the device, select Properties, and click Test Resources.
   (NI-DAQmx) Right-click the device and select Self-Test.
   A dialog box indicates whether the device has passed the test.

Note If the device does not pass the self-test, repeat the instructions in section 5. Installing the Hardware. If the device still does not pass, visit NI Technical Support at ni.com/support.

6. Run the test panels on the device to verify the signal.
   a. Connect a signal to the digitizer and select the appropriate device parameters for this signal such as range, input limits, sample rate, and sample mode.
   b. Access the test panel.
      • (Traditional NI-DAQ (Legacy)) Click Run Test Panels in the Properties window.
      • (NI-DAQmx) Right-click the device and select Test Panels.

Notes For both types of devices, you can enable triggering by clicking the Advanced button on the test panel.

All NI digitizers have self-calibration capabilities. You can access this feature for all NI digitizers programmatically with NI-SCOPE and your ADE, or you can use the Scope SFP. However, only NI-DAQmx devices (SMC-based devices) can be self-calibrated using MAX.

7. Exit MAX when you have finished configuring and testing the digitizer.
7. Programming the Digitizer

You can acquire data interactively using the Scope SFP or programmatically using the NI-SCOPE instrument driver in your application. You can also run the NI-SCOPE examples to demonstrate the functionality of the digitizer.

Acquiring Data Interactively
Launch the Scope SFP from Start»All Programs»National Instruments»NI-SCOPE»NI-SCOPE Soft Front Panel. The Scope SFP provides context-sensitive help for its controls.

Acquiring Data Programmatically
You can use NI-SCOPE to begin programming the digitizer in your ADE. Refer to the Programming section of the NI High-Speed Digitizers Help at Start»All Programs»National Instruments»NI-SCOPE»Documentation.

NI-SCOPE Examples
Programming examples for using NI-SCOPE with LabVIEW, CVI, and C are included on the NI-SCOPE CD. For a complete list of examples and their installed locations, refer to the NI-SCOPE Readme file at Start»All Programs»National Instruments»NI-SCOPE»Documentation.

NI Example Finder
LabVIEW 7.1 or later and LabWindows/CVI 7.1 or later users can use the NI Example Finder to search or browse examples. NI-SCOPE examples are classified by keyword, so you can search for a particular device or measurement function.

To browse for NI-SCOPE examples available in LabVIEW or LabWindows™/CVI™, launch the application, select Help»Find Examples, then navigate to Hardware Input and Output»Modular Instruments»NI-SCOPE (High-Speed Digitizers).

8. Making Your First Measurement

To begin making measurements with an NI high-speed digitizer, complete the following steps:

1. Launch your ADE.
2. Navigate to Start»All Programs»National Instruments»NI-SCOPE»Examples and open one of the examples. If you are not sure which example to run, begin with the Getting Started example.
3. Enter the correct string into the **resource name** control or parameter. This string varies depending on whether the digitizer is a Traditional NI-DAQ device or an NI-DAQmx device. For more information about device names, refer to any of the following resources.
   - Section 6. *Configuring and Testing in MAX*
   - NI-SCOPE VI Reference Help»niScope Initialize
   - NI-SCOPE C Function Reference Help»niScope_init

4. Adjust the parameters, if necessary, to capture the input signal that you want to acquire.

5. Connect the signal that you want to acquire to one of the input channels of the digitizer. For information about the appropriate connections, refer to Appendix A: *Front Panels for SMC-Based Devices* or to Appendix B: *Front Panels for Traditional NI-DAQ (Legacy) Devices*.

6. Run the example program.

**Appendix A: Front Panels for SMC-Based Devices**

This appendix describes digitizer front panels and signal connections for SMC-based devices: NI 5105, NI 5114, NI 5122, NI 5124, NI 5142, NI 5152, and NI 5922.
NI 5105 Front Panels

Figure 5 shows the NI PXI-5105 and NI PCI-5105 front panels.

Table 2 describes the signal connections for the NI 5105.

<table>
<thead>
<tr>
<th>Connector</th>
<th>Description</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>CH 0–CH 7</td>
<td>Standard SMB jack connector</td>
<td>Analog input connection; digitizes data and triggers acquisitions.</td>
</tr>
<tr>
<td>PFI 1</td>
<td>Standard SMB jack connector</td>
<td>Multipurpose PFI line for digital trigger in/out, external clock in, reference clock in/out, and timebase out.</td>
</tr>
</tbody>
</table>
NI 5114 Front Panels

Figure 6 shows the NI PXI-5114 and NI PCI-5114 front panels. For the AUX connector pinout information, refer to Figure 8.

![NI PXI-5114 and NI PCI-5114 front panels](image)

Figure 6. NI 5114 Front Panels

Table 3 describes the signal connections for the NI 5114.

<table>
<thead>
<tr>
<th>Connector</th>
<th>Description</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>CH 0, CH 1</td>
<td>Standard BNC female connector</td>
<td>Analog input connection; digitizes data and triggers acquisitions.</td>
</tr>
<tr>
<td>TRIG</td>
<td>Standard BNC female connector</td>
<td>External analog trigger connection; signals on the TRIG connector cannot be digitized.</td>
</tr>
</tbody>
</table>
Table 3. NI 5114 Front Panel Signal Connections (Continued)

<table>
<thead>
<tr>
<th>Connector</th>
<th>Description</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>CLK IN</td>
<td>Standard SMB jack connector</td>
<td>Input for an external reference or sample clock to the digitizer.</td>
</tr>
<tr>
<td>AUX I/O</td>
<td>9-pin mini-circular DIN connector</td>
<td>Provides access to the multipurpose digital timing and triggering lines, PFI 0, and PFI 1 (with optional cable). For pinout information, refer to Figure 8.</td>
</tr>
</tbody>
</table>

NI 5122/5124/5142/5922 Front Panels

Figure 7 shows the NI 5122/5124/5142/5922 front panels. The NI PXI-5122 and the NI PXIe-5122 front panels are identical.
Table 4 describes the signal connections for the NI 5122/5124/5142/5922.

### Table 4. NI 5122/5124/5142/5922 Front Panel Signal Connections

<table>
<thead>
<tr>
<th>Connector</th>
<th>Description</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>CH 0, CH 1</td>
<td>Standard BNC female connector</td>
<td>Analog input connection; digitizes data and triggers acquisitions.</td>
</tr>
<tr>
<td>TRIG</td>
<td>Standard BNC female connector</td>
<td>External analog trigger connection; signals on the TRIG connector cannot be digitized.</td>
</tr>
<tr>
<td>CLK IN</td>
<td>Standard SMB jack connector</td>
<td><strong>NI 5122/5124/5142</strong>: Input for an external reference or sample clock to the digitizer. <strong>NI 5922</strong>: Input for an external reference clock to the digitizer.</td>
</tr>
<tr>
<td>CLK OUT</td>
<td>Standard SMB jack connector</td>
<td><strong>NI 5122/5124/5142</strong>: Output for the reference or sample clock. <strong>NI 5922</strong>: Output for the reference clock.</td>
</tr>
<tr>
<td>AUX I/O</td>
<td>9-pin mini-circular DIN connector</td>
<td>Provides access to the multipurpose digital timing and triggering lines, PFI 0, and PFI 1 (with optional cable). For pinout information, refer to Figure 8.</td>
</tr>
</tbody>
</table>

Figure 8 shows the pin assignments for the 9-pin DIN connector.

![9-Pin DIN Connector Pin Assignments for NI 5114/5122/5124/5142/5922](image-url)
Figure 9 shows the NI PXI-5152 and NI PCI-5152 front panels.

Table 5 describes the signal connections for the NI 5152.

<table>
<thead>
<tr>
<th>Connector</th>
<th>Description</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>CH 0, CH 1</td>
<td>Standard BNC female connector</td>
<td>Analog input connection; digitizes data and triggers acquisitions.</td>
</tr>
<tr>
<td>TRIG</td>
<td>Standard BNC female connector</td>
<td>External analog trigger connection; signals on the TRIG connector cannot be digitized.</td>
</tr>
<tr>
<td>PFI 0</td>
<td>Standard SMB jack connector</td>
<td>Multipurpose PFI line for reference clock in, sample clock in, and digital trigger in/out.</td>
</tr>
<tr>
<td>PFI 1</td>
<td>Standard SMB jack connector</td>
<td>Multipurpose PFI line for reference clock out, probe compensation, and digital trigger in/out.</td>
</tr>
</tbody>
</table>
Appendix B: Front Panels for Traditional NI-DAQ (Legacy) Devices

This appendix describes digitizer front panels and signal connections for the following Traditional NI-DAQ (Legacy) devices: NI 5102, NI 5112, NI 5620/5621, and NI 5911.

NI 5102 Front Panels

The NI 5102 is available for PXI and PCI platforms. This section describes the front panels and signal connections for both types of NI 5102 digitizers.

(NI PXI-5102) Figure 10 shows the NI PXI-5102 front panel. For the AUX connector pinout information, refer to Figure 11.

![NI PXI-5102 Front Panel](image_url)
Table 6 describes the signal connections for the NI PXI-5102.

**Table 6. NI PXI-5102 Front Panel Signal Connections**

<table>
<thead>
<tr>
<th>Connector</th>
<th>Description</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>CH 0, CH 1</td>
<td>Standard BNC female connector</td>
<td>Analog input connection; digitizes data and triggers acquisitions.</td>
</tr>
<tr>
<td>TRIG</td>
<td>Standard BNC female connector</td>
<td>External analog trigger connection; signals on the TRIG connector cannot be digitized.</td>
</tr>
<tr>
<td>PFI 1</td>
<td>Standard SMB jack connector</td>
<td>Multipurpose digital timing and triggering signal.</td>
</tr>
<tr>
<td>AUX</td>
<td>9-pin mini-circular DIN connector</td>
<td>Access to PFI 2 (with optional cable). For pinout information, refer to Figure 11.</td>
</tr>
</tbody>
</table>

Figure 11 shows the pin assignments for the 9-pin DIN connector on the NI PXI-5102.

![9-Pin DIN Connector for NI PXI-5102, NI PXI/PCI-5112, and NI PCI-5911](image.png)

<table>
<thead>
<tr>
<th>Pin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>+5 V (Fused)</td>
</tr>
<tr>
<td>2</td>
<td>GND</td>
</tr>
<tr>
<td>3</td>
<td>Reserved</td>
</tr>
<tr>
<td>4</td>
<td>Reserved</td>
</tr>
<tr>
<td>5</td>
<td>Reserved</td>
</tr>
<tr>
<td>6</td>
<td>PFI 2</td>
</tr>
<tr>
<td>7</td>
<td>Reserved</td>
</tr>
</tbody>
</table>

**Note** The +5 V signal is fused at 1.1 A. However, NI recommends limiting the current from this pin to 30 mA. The fuse is self-resetting.
Figure 12 shows the NI PCI-5102 front panel.

Figure 12. NI PCI-5102 Front Panel
For signal connection information, refer to Table 7.

**Table 7. NI PCI-5102 Front Panel Signal Connections**

<table>
<thead>
<tr>
<th>Connector</th>
<th>Description</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>CH 0, CH 1</td>
<td>Standard BNC female connector</td>
<td>Analog input connection; digitizes data and triggers acquisitions.</td>
</tr>
<tr>
<td>TRIG</td>
<td>Standard BNC female connector</td>
<td>External analog trigger connection; signals on the TRIG connector cannot be digitized.</td>
</tr>
<tr>
<td>PFI 1</td>
<td>Standard SMB jack connector</td>
<td>Multipurpose digital timing and triggering signal.</td>
</tr>
<tr>
<td>PFI 2</td>
<td>Standard SMB jack connector</td>
<td>Multipurpose digital timing and triggering signal.</td>
</tr>
</tbody>
</table>

**Note**  When used as inputs, NI 5102 PFI lines can trigger an acquisition and/or allow an external sample clock connection.
**NI 5112 Front Panels**

Figure 13 shows the NI PXI-5112 and the NI PCI-5112 front panels. For AUX connector pinout information, refer to Figure 11.

![NI PXI/PCI-5112 Front Panels](image)

Table 8 describes the signal connections on the NI PXI/PCI-5112.

<table>
<thead>
<tr>
<th>Connector</th>
<th>Description</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>CH 0, CH 1</td>
<td>Standard BNC female connector</td>
<td>Analog input connection; digitizes data and triggers acquisitions.</td>
</tr>
<tr>
<td>TRIG</td>
<td>Standard BNC female connector</td>
<td>External analog trigger connection; signals on the TRIG connector cannot be digitized.</td>
</tr>
<tr>
<td>PFI 1</td>
<td>Standard SMB jack connector</td>
<td>Multipurpose digital timing and triggering signal.</td>
</tr>
<tr>
<td>AUX</td>
<td>9-pin mini-circular DIN connector</td>
<td>Access to PFI 2 (with optional cable). For pinout information, refer to Figure 11.</td>
</tr>
</tbody>
</table>

© National Instruments Corporation 23 NI High-Speed Digitizers Getting Started Guide
**NI 5620/5621 Front Panels**

Figure 14 shows the NI PXI-5620/5621 front panels.

![Image of NI PXI-5620/5621 Front Panels](image)

**Table 9. NI 5620/5621 Front Panel Signal Connections**

<table>
<thead>
<tr>
<th>Connector</th>
<th>Description</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>INPUT</td>
<td>Standard SMA female connector</td>
<td>Analog input connection; digitizes data and triggers acquisitions.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NI 5620—50 Ω, AC coupled.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NI 5621—50 Ω, DC coupled.</td>
</tr>
<tr>
<td>REF CLK IN</td>
<td>Standard SMA female connector</td>
<td>50 Ω, 10 MHz, AC coupled reference input.</td>
</tr>
<tr>
<td>PFI 1</td>
<td>Standard SMB jack connector</td>
<td>External digital trigger connection.</td>
</tr>
</tbody>
</table>
**NI 5911 Front Panel**

Figure 15 shows the NI PCI-5911 front panel. For PFI 2 (AUX) connector pinout information, refer to Figure 11.

![NI 5911 Front Panel](image)

Table 10 describes the signal connections for the NI 5911.

<table>
<thead>
<tr>
<th>Connector</th>
<th>Description</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>CH 0</td>
<td>Standard BNC female connector</td>
<td>Analog input connection; digitizes data and triggers acquisitions.</td>
</tr>
<tr>
<td>PFI 1</td>
<td>Standard SMB jack connector</td>
<td>Multipurpose digital timing and triggering signal.</td>
</tr>
<tr>
<td>PFI 2 (AUX)</td>
<td>9-pin mini-circular DIN connector</td>
<td>Access to PFI 2 (with optional cable). For pinout information, refer to Figure 11.</td>
</tr>
</tbody>
</table>
Appendix C: Troubleshooting

Front Panel ACCESS LED on PXI Module is Off When PXI Chassis is On

If the ACCESS LED on the digitizer is not lit after you power on the PXI chassis, a problem may exist with the PXI power rails, a hardware device, or the LED.

Note  The LEDs may not light until the device has been configured in MAX. Before troubleshooting this issue, verify that the device appears in MAX.

Complete the following steps to troubleshoot this issue:
1. Power off your PXI chassis.
2. Disconnect any signals from the PXI module front panel.
3. Remove the PXI module and inspect for signs of damage. Do not reinstall a damaged device.
4. Reinstall the PXI module as described in step 5. Installing the Hardware.
5. Power on the PXI chassis.
6. Verify that the device appears in MAX.
7. Reset the device in MAX and perform a self-test. For information about performing device resets and self-tests in MAX, refer to step 6. Configuring and Testing in MAX.
8. If the ACCESS LED still fails to light, contact NI Technical Support at ni.com/support.

Device Does Not Appear in MAX

Complete the following steps if the device does not appear in MAX:
1. In the MAX Configuration pane, click Devices and Interfaces to expand the category.
2. Click Traditional NI-DAQ Devices or NI-DAQmx Devices and press <F5> to refresh the list of installed devices.
3. If the device is still not listed, power down the system, verify that the device is correctly installed, and restart.
4. If the device still does not appear under Devices and Interfaces, contact NI Technical Support at ni.com/support.
Device Failed the Self-Test
The MAX self-test performs a brief test of device resources. If the device does not pass the self-test, complete the following steps:
1. Reboot your system.
2. Launch MAX and perform the self-test again. If the device still fails the self-test, proceed to step 3.
3. Uninstall and reinstall NI-SCOPE.
4. If the device still fails the self-test, contact NI Technical Support at ni.com/support.

Thermal Shutdown Error
I received an over temperature (or thermal shutdown) error, and my device shut down. What should I do next?
To reenable your device after thermal shutdown, complete the following steps:
1. Power down the computer or chassis that contains the device.
2. Review the procedure in step 5. Installing the Hardware and make any necessary adjustments to make sure that your device is effectively cooled.
3. Power up the computer or chassis.

Note The thermal shutdown error is reported until the device has cooled down to an acceptable operating temperature and has been successfully reset.

Performance Issues Using MXI Connections
If you are using a MXI interface to control a PXI chassis and you encounter performance or initialization issues, refer to the MXI documentation to verify that the MXI interface is properly set up. Software optimization might be necessary.

• (MXI-3) For optimization, select Start»All Programs»National Instruments MXI-3»MXI-3 Optimization. Using a MXI-3 connection without running this application may result in an error message such as the following:
  - maximum amount of time exceeded
  - internal software error

If the software optimization application is not installed on your system, use the MXI software CD or the National Instruments Driver CD included with your kit to install the software. After installation, you may need to reboot your computer before running the MXI Optimization Application.
• **(MXI-4 and MXI-Express)** Optimization is performed automatically by the hardware.

If you continue to have initialization or performance issues, refer to the MXI documentation at Start»All Programs»National Instruments MXI, or visit NI Technical Support at ni.com/support.

**Setting Up SMC-Based Devices for Synchronization**

*Note* The following step is required for any type of synchronization involving an SMC-based device, including NI-TClk synchronization. For information about NI-TClk synchronization, refer to NI High-Speed Digitizers Help» Programming»NI-TClk Synchronization Help.

If you plan to share triggers and/or clocks for the purpose of synchronizing SMC-based devices (NI 5105/5114/5122/5124/5142/5152/5922), you must identify or configure certain components in MAX.

**(PXI and PXIe Modules)** You must identify the PXI/PXIe system controller by completing the following steps:

1. In the MAX configuration tree,
   a. Right-click **PXI System»Identify As**.
   b. Select your controller from the list. For example, select External PC if you are using a MXI controller in an external PC.
2. Expand the PXI System tree and right-click the name of the chassis you are using.

**(PCI Devices)** You must configure the RTSI cable by completing the following steps:

1. Connect a RTSI cable between the PCI devices to physically share triggers and/or clocks.
2. In the MAX configuration tree,
   a. Right-click **NI-DAQmx Devices**.
   b. Select Create New **NI-DAQmx Device»RTSI Cable**.
   c. Right-click the RTSI cable, then select the device to add to the RTSI cable.

**NI 5112 Programming Practices**

NI 5112 digitizers contain electromechanical relays that may require special programming practices to prevent excessive wear. For more information, refer to the NI High-Speed Digitizers Help» Devices»NI 5112 Overview» Electromechanical Relays.
Appendix D: Where to Go for Support

The National Instruments Web site is your complete resource for technical support. At ni.com/support you have access to everything from troubleshooting and application development self-help resources to email and phone assistance from NI Application Engineers.

A Declaration of Conformity (DoC) is our claim of compliance with the Council of the European Communities using the manufacturer’s declaration of conformity. This system affords the user protection for electronic compatibility (EMC) and product safety. You can obtain the DoC for your product by visiting ni.com/certification. If your product supports calibration, you can obtain the calibration certificate for your product at ni.com/calibration.

National Instruments corporate headquarters is located at
11500 North Mopac Expressway, Austin, Texas, 78759-3504.
National Instruments also has offices located around the world to help address your support needs. For telephone support in the United States, create your service request at ni.com/support and follow the calling instructions or dial 512 795 8248. For telephone support outside the United States, contact your local branch office:

Australia 1800 300 800, Austria 43 662 457990-0,
Belgium 32 (0) 2 757 0020, Brazil 55 11 3262 3599, Canada 800 433 3488,
China 86 21 6555 7838, Czech Republic 420 224 235 774,
Denmark 45 45 76 26 00, Finland 385 (0) 9 725 72511,
France 33 (0) 1 48 14 24 24, Germany 49 89 7413130,
India 91 80 41190000, Israel 972 3 6393737, Italy 39 02 413091,
Japan 81 3 5472 2970, Korea 82 02 3451 3400,
Lebanon 961 (0) 1 33 28 28, Malaysia 1800 887710,
Mexico 01 800 010 0793, Netherlands 31 (0) 348 433 466,
New Zealand 0800 553 322, Norway 47 (0) 66 90 76 60,
Poland 48 22 3390150, Portugal 351 210 311 210, Russia 7 495 783 6851,
Singapore 1800 226 5886, Slovenia 386 3 425 42 00,
South Africa 27 0 11 805 8197, Spain 34 91 640 0085,
Sweden 46 (0) 8 587 895 00, Switzerland 41 56 2005151,
Taiwan 886 02 2377 2222, Thailand 662 278 6777,
Turkey 90 212 279 3031, United Kingdom 44 (0) 1635 523545